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Smoke Movement in Atrium Buildings 
In this example you will simulate smoke movement in an atrium with and without extraction fans. Some 

new concepts in this example include: 

• More complex geometry. 

• Using multiple meshes. 

• Defining a fan activation control that uses input from multiple smoke detectors. 

• Using extraction fans created with HVAC components.  

 

Figure 1: Velocity contours with fans. 

This tutorial demonstrates how to: 

• Create the atrium geometry. 

• Use multiple meshes with open boundaries. 

• Define a Heat Release Rate fire. 

• Create smoke detectors and a control. 

• Define HVAC fans and vents that are activated by the control. 

Our simulation will replicate the model described by Chew and Liew, 2000. The geometry of the problem 

is shown in Figure 2. 



  
Atrium Smoke Movement 

 

 

There are two openings of 5 m by 5 m at the first level for air inlet, and eight powered 

extraction fans with discharge capacity of 20 m3/s, each located at the smoke 

reservoir. Each level has a 10 m by 60 m floor plate on both sides with the central 

opening forming the atrium and the smoke reservoir. The numerical experiment NA is 

a 5-storey atrium of 30 m high and NB is an 11-storey atrium of 60 m high. 

The fire source was modelled by defining heat flux at one designated location of the 

fire outbreak. Mobile stores were located in the atrium. The fire size was assumed to 

be 5 MW 

 

Figure 2: Geometry of atrium NA (image from Chew and Liew, 2000) 

We will make the following assumptions: 

• The floor height is 6 m. 

• The floor, walls, and floor plates are concrete 0.3 m thick. 

• The roof is insulated (adiabatic).  

Throughout this example, the instructions will describe data input using menu dialogs. This is done for 

clarity and consistency. However, PyroSim provides both drawing tools and shortcut toolbars that can 

speed many of these tasks. The user is encouraged to experiment with these alternate approaches to 

model creation. 

1. Select SI Units 
To select SI units: 

1. On the View menu, click Units and select SI to display values using the metric system. 
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2. Name and Save the Model 
It is a good idea to save your model at the start. This will make it possible for you to save it at any time in 

the future and return to continue your work. 

1. On the File menu, click Save. 

2. Choose a location to save the model. Because FDS simulations generate many files and a large 

amount of data, it is a good idea to use a new folder for each simulation. For this example, we 

will create an Atrium folder and name the file atrium.psm. 

3. Click OK to save the model. 

3. Concrete Material 
To create the concrete walls and floor, we first create a concrete material. This defines the conductivity 

and other thermal properties of the concrete. 

1. On the Model menu, click Edit Materials. 

2. Click Add From Library. 

3. From the list of materials in the Library, click CONCRETE and then click the left arrow (<--) to 

move concrete into the Current Model. Click Close to close the library.  

4. Click OK to close the Edit Materials dialog. 

4. Concrete Surface 
The concrete surface will be used when we make the floor, walls, and floor plates. We will use a Layered 

surface so that thermal conduction into the surface will be included in the calculation. We will use a 0.3 

m thick slab of concrete and has a back face boundary condition to ambient air (PyroSim default). To 

define the surface:  

1. On the Model menu, click Edit Surfaces. 

2. Under the surface list on the left side of the dialog, click New.  

3. In the Surface Name box type Concrete. In the Surface Type list, click Layered. Click OK. 

4. In the Material Layers tab, click on the first row and in the Thickness column, type .3.  

5. In the row, click Edit.  

6. In the Mass Fraction box type 1 and in the Material list, click CONCRETE. Click OK. 

7. Click OK to close the Edit Surfaces dialog. 

5. Create the Model Geometry 
In building this model, we will include all exterior walls and simulate flow out of the building ends and 

above the building. We do this both because it makes the final visualization more realistic and because 

the ground and open space above the building can affect the flow. 

In parts of the model we will use a solution grid of 0.5 m, therefore the geometry is described at that 

level of resolution. This prevents thin walls or floors from snapping down to the mesh in regions where 

we use a finer (0.25 m) mesh.   
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Floor 

First add the floor. The floor will be a vent with a concrete surface. As discussed in previous examples, a 

vent in FDS has a general meaning of a boundary condition on a surface. In this case, the boundary 

condition is the floor. 

1. On the Model menu, click New Vent. 

2. In the ID box, type Floor. 

3. In the Surface list, click Concrete. 

4. Click the Geometry tab. 

5. In the Min X box, type 0 and in the Max X box, type 30. 

6. In the Min Y box, type -2 and in the Max Y box, type 62. 

7. Click OK to create the vent. 

8. On the View menu, click Reset View to All Objects (or press CTRL+R). 

Floor Plates 

Next create the floor plates. These will be dimensioned to meet the walls at the interior surfaces.  

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Floor Plate. 

3. Click the Geometry tab. 

4. In the Min X box, type 0 and in the Max X box, type 10. 

5. In the Min Y box, type 0 and in the Max Y box, type 60. 

6. In the Min Z box, type 6 and in the Max Z box, type 6.5. 

7. Click the Surfaces tab. 

8. In the Single list, click Concrete. 

9. Click OK to create the obstruction. 

Now we will copy this floor plate vertically. 

1. Right-click on the Floor Plate and click Copy/Move. 

2. For Mode, select Copy and in the Number of Copies box, type 3. 

3. In the Offset Z box, type 6. 

4. Click OK to copy. 

Now we will copy the four floor plates horizontally. 

1. Holding the CNTRL key, click to select all four floor plates. 

2. Right-click on the selection and click Copy/Move. 

3. For Mode, select Copy and in the Number of Copies box, type 1. 

4. In the Offset X box, type 20. 

5. Click OK to copy. 

Exterior Walls 

Now add the exterior walls. These will be obstructions with concrete surfaces. First the front wall. 
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1. On the Model menu, click New Obstruction. 

2. In the ID box, type End Wall. 

3. Click the Geometry tab. 

4. In the Min X box, type 0 and in the Max X box, type 30. 

5. In the Min Y box, type 59.5 and in the Max Y box, type 60. 

6. In the Min Z box, type 0 and in the Max Z box, type 30. 

7. Click the Surfaces tab. 

8. In the Single list, click Concrete. 

9. Click OK to create the obstruction. 

Now the front smoke reservoir at the top of the wall. 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type End Reservoir. 

3. Click the Geometry tab. 

4. In the Min X box, type 10 and in the Max X box, type 20. 

5. In the Min Y box, type 59.5 and in the Max Y box, type 60. 

6. In the Min Z box, type 30 and in the Max Z box, type 36. 

7. Click the Surfaces tab. 

8. In the Single list, click Concrete. 

9. Click OK to create the obstruction. 

Now the end door. Note that the boundaries of the hole extend past the wall to ensure the hole is 

properly cut in the FDS mesh. 

1. On the Model menu, click New Hole. 

2. In the ID box, type End Door. 

3. Click the Geometry tab. 

4. In the Min X box, type 12.5 and in the Max X box, type 17.5. 

5. In the Min Y box, type 59 and in the Max Y box, type 60.5. 

6. In the Min Z box, type 0 and in the Max Z box, type 5. 

7. Click OK to create the hole. 

Copy the front wall, reservoir, and door to the back. 

1. Press the CTRL key and click to select the End Wall, End Reservoir, and End Door.  

2. Right-click and click Copy/Move. 

3. For Mode, select Copy and in the Number of Copies box, type 1. 

4. In the Offset Y box, type -59.5. 

5. Click OK to copy. 

In the upper toolbar, select the display option Realistic with Outlines and your model should look like 

Figure 3. 



  
Atrium Smoke Movement 

 

 

 

Figure 3: Model after adding floor, floor plates, and front and back walls. 

Now the right side wall. 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Side Wall. 

3. Click the Geometry tab. 

4. In the Min X box, type 29.5 and in the Max X box, type 30. 

5. In the Min Y box, type 0 and in the Max Y box, type 60. 

6. In the Min Z box, type 0 and in the Max Z box, type 30. 

7. Click the Surfaces tab. 

8. In the Single list, click Concrete. 

9. Click OK to create the obstruction. 

Copy the right side wall. 

1. Right-click on the Right Side wall and click Copy/Move. 

2. For Mode, select Copy and in the Number of Copies box, type 1. 

3. In the Offset X box, type -29.5. 

4. Click OK to copy. 

Roof 

We will use copy and edit functions to create the roof. 

1. Press the CTRL key and click to select the two upper Floor Plates, Error! Reference source not 

found.. 

2. Right-click on a selected floor plate and click Copy/Move. 

3. For Mode, select Copy and in the Number of Copies box, type 1. 
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4. In the Offset Z box, type 5.5. 

5. Click OK to copy. 

Edit the two roof panels. 

1. Press the CTRL key and select the two newly copied obstructions, right-click and click Properties. 

2. In the ID box, type Roof. 

3. Click the Surfaces tab. 

4. In the Single list, click ADIABATIC. 

5. Click OK to change the properties. 

Now add the roof panels that cover the smoke reservoir. Make three new obstructions with the 

dimensions shown in Table 1 and with adiabatic surfaces. 

Table 1: Geometry of smoke reservoir panels 

Name Min X Max X Min Y Max Y Min Z Max Z 

Reservoir 1 10.0 10.5 0.0 60.0 29.5 36.0 

Reservoir 2 19.5 20.0 0.0 60.0 29.5 36.0 

Reservoir 3 10.0 20.0 0.0 60.0 35.5 36.0 

 

Press the CTRL key and select the +X Side Wall and Reservoir 2 wall, then right-click and select Hide 

Objects. At this point, your model should look like Figure 4. 

 

Figure 4: After walls and roof have been added. In this figure, the right wall and right reservoir have 
been hidden. 
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6. Define Fire 

Reaction 

We will first change the reaction to Propylene. This fire will produce less smoke than the default 

Polyurethane reaction. 

1. On the Model menu, click Edit Reactions. 

2. Under the reaction list on the left of the dialog, click Add From Library. 

3. In the Library list, click PROPYLENE and then click the left arrow (<--) to move reaction into the 

Current Model. Click Close to close the library.  

4. Click OK to close the Edit Reactions dialog. 

Burner Surface 

The burner surface will define heat release rate to the simulation. We want a total heat release rate of 5 

MW, which will be distributed over a 9 m2 area. The fire will ramp to the full value and extinguish at 50 

seconds. To define the surface:  

1. On the Model menu, click Edit Surfaces. 

2. Under the surface list on the left of the dialog, click New. 

3. In the Surface Name box type Burner. In the Surface Type list, click Burner. Click OK. 

4. In the Heat Release Rate Per Area box type 555.6 (5000 kW HRR divided by 9 m2). 

5. In the Ramp-Up Time, select Custom. Click Edit Value and type in the values given below, then 

click OK. 

Time Fraction 

0 0 

1 1 

50 1 

51 0 

100 0 

 

6. Click the Thermal tab, for the Boundary Condition Model select Fixed Temperature. For Surface 

Temperature, type 500. For Emissivity, type 0.9. 

7. Click OK to close the Edit Surfaces dialog. 

The fire will be defined on the top surface of a 3x3x0.5 m obstruction located under the lower floor 

plate.  

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Burner. 

3. Click the Geometry tab. 

4. In the Min X box, type 20 and in the Max X box, type 23. 

5. In the Min Y box, type 28.5 and in the Max Y box, type 31.5. 

6. In the Min Z box, type 0 and in the Max Z box, type .5. 



  
Atrium Smoke Movement 

 

 

7. Click the Surfaces tab. 

8. Select Multiple and in the Surface list for the Max Z face, click Burner (Error! Reference source 

not found.). 

9. Click OK to create the obstruction. 

7. Computational Mesh 
For this fire, D* is 1.825 m. We will use a grid size of 0.25 at the fire location (~D*/7) and 0.50 m away 

from the fire. The easiest way to do this is to define two meshes that cover the entire model and then 

split the mesh around the fire. To create the mesh in the main building: 

1. On the Model menu, click Edit Meshes 

2. Click New and then click OK to create the new mesh. 

3. In the Min X box, type 0 and in the Max X box, type 30. 

4. In the Min Y box, type -2 and in the Max Y box, type 62. 

5. In the Min Z box, type 0 and in the Max Z box, type 30 

6. In the X Cells box, type 60. 

7. In the Y Cells box, type 128. 

8. In the Z Cells box, type 60. 

9. Click Apply to save changes to that mesh. 

Now we add the mesh that will represent the smoke reservoir and the exterior of the building above the 

reservoir. That will allow us to visualize the smoke leaving the building. 

1. In the Edit Meshes dialog, click New and then click OK to create the new mesh. 

2. Click OK to create the new mesh. 

3. In the Min X box, type 10 and in the Max X box, type 20. 

4. In the Min Y box, type 0 and in the Max Y box, type 60. 

5. In the Min Z box, type 30 and in the Max Z box, type 50 

6. In the X Cells box, type 20. 

7. In the Y Cells box, type 120. 

8. In the Z Cells box, type 40. 

9. Click OK to save changes and close the Edit Meshes dialog. 

We now have two meshes that could be used to solve the problem. The mesh that represents the 

building has 460 800 cells and the mesh that represents the smoke reservoir has 96 000. We will split 

the building mesh for two reasons: to more evenly distribute calculations between processors and to 

refine the mesh at the fire.  

To split the mesh, we will use the Mesh Split tool: 

1. In the upper toolbar, click Show Mesh Divisions. 

2. In the Navigation View, select Mesh01 and then select the Split Mesh tool, Figure 5. 

3. Drag the cursor along the lower edge of the mesh until it displays Y=27.0 m, then click, Figure 6. 
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4. Continue dragging the cursor along the lower edge of the mesh until it displays Y=33.0 m, then 

click. 

5. Now, right-click and select Finish. The original mesh is now split into three meshes. 

 

Figure 5: Select the Split Mesh tool 

 

Figure 6: By moving cursor along edge, set the split mesh location, then click. 

The new middle mesh now includes the fire. To refine this mesh:  

1. In the Navigation View, select Mesh01-b (the middle mesh), right-click and then select 

Properties. 

2. In the X Cells box, type 120. 

3. In the Y Cells box, type 24. 
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4. In the Z Cells box, type 120. 

5. Click OK. 

8. Add Open Vents on the Mesh Boundaries 
The default FDS assumption is that mesh boundaries are closed and with INERT surfaces. We will add 

OPEN vents to the mesh boundaries on the front, back, and top of the model.    

Front of Atrium 

To add OPEN vents to the front boundary. 

1. In the Navigation View, right-click Mesh01-c (the front mesh) and click Open Mesh Boundaries, 

Figure 7. This will add seven OPEN vents to the model. 

2. Edit the XMAX and XMIN vents and on the Geometry tab, in the MIN Y box type 60. 

3. Delete the two OPEN vents over the roof. 

4. Delete the ZMIN vent. 

There should now be four OPEN vents on the front of the building, Figure 8. 

Back of Atrium 

Repeat these steps to add OPEN vents to the back of the atrium (MESH01-a). Edit the XMAX and XMIN 

vents and on the Geometry tab, in the MAX Y box type 0. There should be four open vents at the back of 

the building. 

 

Figure 7: Open mesh boundaries 
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Figure 8: Open vents on front of atrium 

Top of Smoke Reservoir 

To add OPEN vents to the top of the smoke reservoir. 

1. In the Tree View, right-click Mesh02 (the smoke reservoir mesh) and click Open Mesh 

Boundaries. This will add six OPEN vents to the model. 

2. Edit the side (XMAX and XMIN), back (YMIN), and front (YMAX) vents and on the Geometry tab, 

in the MIN Z box type 36. 

As shown in Figure 9, there should now be open vents on the front, back, and top of the model. 

 

Figure 9: Final OPEN vents on mesh boundaries 
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9. Add Detectors 
Detectors are used to detect the fire and can then be used as part of a control that initiates an action 

such as activating extraction fans. To define the detectors: 

1. On the Devices menu, click New Smoke Detector. 

2. In the Name box, type Smoke Detector. We will use the default detector. 

3. In the Location boxes, type the X, Y, and Z coordinates as 25, 10, and 5.5. The detectors must 

not be on a surface, but free-standing in the air. 

4. Click OK to close the New Smoke Detector dialog. 

5. Now right-click the Smoke Detector and click Copy/Move. 

6. Make 4 copies, each offset by 10 m in the Y direction. 

10. 2D Slice Planes 
Slice planes are used to display 2D contours. In this analysis, we will save temperature, velocity, and 

visibility data for future plotting. To define the slice planes: 

1. On the Output menu, click 2D Slices. 

2. Fill the table by entering the values in Table 2. You can click on the row number to select entire 

rows to copy and paste, speeding the entry. 

3. Click OK to close the Animated Planar Slices dialog. 

4. Click the Show Slices tool to enable/disable display of the slices. 

Table 2. Slice plane data 

XYZ Plane Plane Value (m) Gas Phase Quantity Use Vector? Cell Centered? 

X 15 Velocity YES NO 

X 15 Temperature NO NO 

X 15 Visibility NO NO 

Y 6 Velocity YES NO 

Y 21 Velocity YES NO 

Y 36 Velocity YES NO 

Y 51 Velocity YES NO 

Y 30 Velocity YES NO 

Y 30 Temperature NO NO 

Y 30 Visibility NO NO 

 

11. 3D Slices 
FDS has two methods to output 3D data: 3D slices and Plot3D data. 3D slices (a 3D region for plotting 

data) is usually recommended, since it uses a more compact storage. We will plot temperature data for 

illustration. 

1. On the Output menu, click 3D Slices. 

2. In the Name box, type Temperature. 
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3. In the Min X box, type 0 and in the Max X box, type 30. 

4. In the Min Y box, type -2 and in the Max Y box, type 62. 

5. In the Min Z box, type 0 and in the Max Z box, type 50 

6. Select NO for Use Vector? and Cell Centered?. 

7. Repeat for Velocity and Visibility. 

8. Click OK to close the Animated 3D Slices dialog. 

12. Specify Simulation Properties 
We will run the simulation for 100 seconds. 

1. On the Analysis menu, click Simulation Parameters. 

2. In the End Time box, type 100. 

3. Click OK. 

13. Optional - Run the Simulation 
If desired, you can skip to section 15 and run the simulation without extraction fans.  

14. Add Smoke Extraction Fans 
There are two approaches we could take in defining the smoke extraction fans. The simplest would be to 

create what PyroSim calls Exhaust vents and position them at the top of the smoke reservoir. Then, the 

user can just specify the flow rate and connect the activation of the fans to the detectors, using controls. 

This is simple, but the smoke will just disappear from the model.  

It is much more visually interesting if we use HVAC fans that will display the smoke being extracted from 

the building. The following instructions describe HVAC fans. We must define a vent on the top and 

bottom of the smoke reservoir obstruction. Then, we will connect the two vents with two ducts in 

series: the first duct will have a fan and the second duct a damper. The damper is used to set flow 

through the duct to zero and will open when connected to the detectors through the controls. 

Add Vents 

To add the 2x2 m vents: 

1. On the Model menu, click New Vent. 

2. In the ID box, type Extraction Bottom. 

3. In the Surface list, click HVAC. 

4. Click the Geometry tab. 

5. In the Plane list, click Z and in the box, type 35.49 (the small offset avoids flashing when rotating 

and the vent will snap to the grid during the solution).  

6. In the Min X box, type 12 and in the Max X box, type 14. 

7. In the Min Y box, type 5 and in the Max Y box, type 7. 

8. Click OK then click OK again to accept the HVAC warning and create the vent. 

We repeat for the vent on the top surface of the obstruction: 
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1. On the Model menu, click New Vent. 

2. In the ID box, type Extraction Top. 

3. In the Surface list, click HVAC. 

4. Click the Geometry tab. 

5. In the Plane list, click Z and in the box, type 36.01 (the small offset avoids flashing when rotating 

and the vent will snap to the grid during the solution).  

6. In the Min X box, type 12 and in the Max X box, type 14. 

7. In the Min Y box, type 5 and in the Max Y box, type 7. 

8. Click OK then click OK again to accept the HVAC warning and create the vent. 

HVAC Fan 

This creates a fan that we can use in the HVAC ducts. 

1. On the Model menu, click Edit HVAC 

2. Click New and in the Type list, click Fan. In the Name box, type Smoke Fan. 

3. Select Constant Flow and in the Volume Flow Rate box, type 16. 

4. Click OK to close the Edit HVAC dialog. 

HVAC Nodes and Ducts 

Ducts connect the two vents. Ducts need two end nodes that we will create at the vents. The ducts will 

contain fans. 

Add the bottom and top HVAC nodes that correspond to the HVAC vents: 

1. In the navigation view, right-click the Extraction Bottom vent. 

2. Click Add HVAC Nodes. This will make a new HVAC node named Node01. 

3. In the tree view, right-click on Node01. 

4. Click Rename. 

5. Type in the name Extraction Bottom, and hit the Enter key. 

Repeat for the Extraction Top vent: 

1. In the tree view, right-click the Extraction Top vent. 

2. Click Add HVAC Nodes. 

3. In the tree view, right-click on Node02. 

4. Click Rename. 

5. Type in the name Extraction Top, and hit the Enter key. 

Now create the HVAC fan duct. A control will be added to turn on the fan when a smoke detector 

activates. Note that even with the fan off, a small amount of flow through the duct can occur. To 

completely block flow, add a damper duct in series with the fan duct. 

1. On the Model menu, click New HVAC Duct. 

2. In the ID box, type Fan Duct. 

3. In the Node 1 list, click Extraction Bottom.  
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4. In the Node 2 list, click Extraction Top.  

5. Select Non-circular and in the Area box, type 4, in the Perimeter box, type 8. 

5. Click the Flow Model tab. 

6. In the Flow Device list, click Fan (not Basic Fan).  

7. In the Fan list, click Smoke Fan. This selects the HVAC fan we created earlier. 

8. In the Activation list, click New.  

9. In the Name box, type Fire Detector Control and click OK to create the control. 

10. For Input Type, select Detector.  

11. In the text description, click <nothing> and select all five smoke detectors, then click OK.  

12. Click OK again to close the New Control dialog. 

13. Click OK to close the HVAC Duct Properties dialog. 

Now we will copy these smoke extraction vents to make a row. 

1. Holding the CTRL key, click on the Extraction Bottom vent, the Extraction Top vent, the 

Extraction Bottom HVAC node, the Extraction Top HVAC node, and the Fan Duct.  

2. Right-click the selected objects and click Copy/Move. 

3. For Mode, select Copy and in the Number of Copies box, type 3. 

4. In the Offset Y box, type 16. 

5. Click OK to copy. 

Now we will copy the four extraction vents to a new row. 

1. All the copied objects will be selected (alternately, select all copies of the vents, nodes, and 

ducts we just created). 

2. Right-click on the selection and click Copy/Move. 

3. For Mode, select Copy and in the Number of Copies box, type 1. 

4. In the Offset X box, type 4. 

5. Click OK to copy. 

At this point, your model should look like Figure 10, with vents and fans located in the top of the roof. 
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Figure 10: Model after HVAC ducts and fans are added (labels have been toggled off and the Reservoir 
3 obstruction has been hidden) 

15. Save the Model 
1. On the File menu, click Save.  

2. Click Save to save the model. 

16. Run the Simulation 
1. On the FDS menu, click Run FDS Parallel. Note that we can use parallel processing because we 

defined four meshes. 

2. The FDS Simulation dialog will appear and display the progress of the simulation.  

3. During the analysis, periodically view Results just to ensure that the solution is proceeding 

satisfactorily. 

4. When the simulation is complete, PyroSim Results will launch automatically and display a 3D 

image of the model. 

17. View Smoke and HRRPUA 
We use PyroSim Results to view the smoke and heat release rate per unit volume. 

1. In the PyroSim Results window, double click the 3D Smoke menu in the tree. This will load both 

the HRRPUV and Soot Mass Fraction data sets for all meshes. Select Wireframe Render. 
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Figure 11: Dense smoke in the atrium at 45 seconds. Extraction fans activated. 

In 3D Slices, double-click Temperature to display temperature isosurfaces. Click the colorbar to highlight 

a value, right-click to turn off highlight. Double-click the colorbar to change plot properties. 

 

Figure 12: Temperature isosurfaces at 45 seconds. 
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18. View Slice Data 
We can use 2D slice data to view output on planes (you can also define slices through the 3D slice data). 

We will view the velocity vectors. 

1. In Results window, double-click 2D Slice Vectors > VELOCITY. 

At 45 seconds, the evacuation fans are operating and air is entering through the open doors, Figure 13. 

 

Figure 13: Velocity slice display showing fans extracting air at 45 s. 
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